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Adobe Dreamweaver 2021 

8 – Extra Challenge 
 

The Challenge 
Now it’s time to challenge the serious web developers among you. In this section we will create a 

website that will bring together skills learned in all the previous exercises and adds a few new ones. 

In many sections, rather than tell you what to do, you will need to apply what you have learned 

previously to accomplish a certain result. For those who have easily done everything in the previous 

sections, here’s a test of your skills. 

The Task 
Your task in this section is to create a website for the Nuklear 

family. They want you to create a website to tell the world about 

them. Are you up to the task? Time to find out. 

Planning 
Most good websites begin with some good planning and 

this one will be no different. The Nuklear family have 

thought long and hard about what they want in their 

website and have given you a rough Site Map as shown below. 

 

Of course, Nick Nuklear knows a thing or two about computers so he whipped up a slightly fancier 

version as shown on the following page (A website’s planning can be anything from rough sketches 

to formal illustrations but the important thing is that it needs to give you a clear idea of what the site 

will have. 

Note Before you begin, make sure you have the images for these exercises saved in the location 
where you intend to create the Nuklear Family Website. 
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Nuklear Family Website 

 

After deciding on the content of the site, the family decided on exactly how they wanted each page 

to look. A rough design plan for the home page is shown below. More detailed or neater plans for 

each page could be created and definitely would be for a professional site.  

 

 

  

Home

News Town Friends Family

Winston Elizabeth

Lizzy Nick

Pets

Click Family to 

show sub menu 
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Exercise 1. Creating the Site 

Assuming all the site planning is complete, we can now begin to create the site itself in 

dreamweaver. 

1. Create a new site, selecting a suitable location for the files in the site to be saved in. Make sure 

the exercise files for this website (a folder including all of the images required for the site) are 

saved in the same location. Give the site a suitable name. If you can’t remember how, the 

pictures below should give you some clues. 

 

 

 

 

 

2. Once you have a site we will create a new HTML document that we will then use as the basis for 

our other pages (you could also create a template but we won’t be creating many pages). Create 

a new document with the filename index.html and save it. 

 

3. Open the page and set the title the page to Nuklear Family Website. 
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Exercise 2. Creating the Page Structure 

First, we’ll create the structure of the page using HTML. Then we will use CSS for presentation and 

layout. 

1. From the Insert menu add a Navigation section to the document (or type it directly in the HTML 

code if you prefer). 

 

 

2. Add a Main section with a Header section and an Article section inside it. 

3. Add a Footer section after the Main section. 

 

 

4. Change the text in the Header section to Welcome to the Nuklear Family Website. 

5. Replace the text in the Article section with 2 paragraphs as follows. The link shown should go to 

the news.html page which we will create later on. 

Welcome to the website of the Nuklear family. We hope you will enjoy browsing through our site 

and finding out about our family. 

Take a look at the news page to see pictures of our family vacation to lovely Batu. 

<article> 

 <p>Welcome to the website of the Nuklear family. We hope you will enjoy 

browsing through our site and finding out about our family.</p> 

 <p><a href="news.html">Take a look at the news page</a> to see pictures of our 

family vacation to lovely Batu.</p> 

</article> 
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6. Add some text © Nuklear Family to the Footer section including the copyright symbol. 

<footer> 

 <p>&copy; Nuklear Family</p>  

</footer> 

 

Lastly, we’ll add some navigation to the site. 

7. In the Navigation section, add an unordered list like the following. Note that the last half of the 

list is indented under Family so we will have a list within a list. You can do this by turning all of 

the lines in to a list, then selecting the bullet points that need to be indented and then clicking 

the Indent icon  in the properties panel.  

 
 

 
 

8. Now turn each of the points into a link to the pages we will create later on. The family one won’t 

be a link yet as we will turn that into a button that shows / hides the list below it. 

 
 

 
 

 

9. We will also add a similar navigation in the footer area except that in this case it will consist of 2 

separate unordered lists. 
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Exercise 3. Page Layout 

1. Add a tag in the HEAD section of your HTML to set the viewport for the page. 

<meta name="viewport" content="width=device-width, initial-scale=1.0"> 

2. Create a new CSS file and save it with a suitable filename. 

 

 

3. Create a new * selector to set the global margins to 0. 

 

4. Create a new HTML selector to set the background colour of the page to rgba(23,28,49,1.00). 
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5. Add some CSS comments to your CSS file which will be used to organise the different style rules. 

 

6. Under the type comment, add another html style rule to set the base font for the document. 

html { 

  font-family: Cambria, "Hoefler Text", "Liberation Serif", Times, "Times New Roman", serif; 

  font-size: 10px; 

} 

7. Under the general comment, add a style rule for the body element. 

body { 

  background-color: rgba(255,255,255,0.85); 

  width: 80%; 

  max-width: 1100px; 

  margin: 0px auto; 

} 

 

8. Under the navigation comment, add a style rule for the nav element. 

nav { 

  font-size: 1.7rem; 

  margin: 0; 

  padding: 0; 

  width: 200px; 

  position: fixed; 

  height: 100%; 

  background-color: rgba(23,28,49,1.00); 

  font-family: Gotham, "Helvetica Neue", Helvetica, Arial, sans-serif; 

} 
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9. Under the main comment, add a style rule for the main element. 

main { 

  margin: 0px 0px 0px 200px; 

  padding: 0px; 

  min-height: 100vh; 

  font-size: 1.6rem; 

} 
 

Note When you combine properties for margins, padding into a single line the first number is for 

the top, then right, bottom and left (going clockwise from top). So, in this example the rule 

says the top, right and bottom will have 0 margin while the left will have 200px margin. 

 The height is set to 100vh (vh = viewport height), making the page take up all of the visible 

height. 

10. Add another style rule for the header element. 

header { 

  background-color: rgba(23,28,49,1.00); 

  color: white; 

  font-size: 3rem; 

  text-align: center; 

  font-family: Gotham, "Helvetica Neue", Helvetica, Arial, sans-serif; 

  height: 5.5rem; 

  line-height: 5rem; 

} 
 

Tip Remember if you want to learn more about any html or css in your code then click on the 

part you want information about (for example click on the line-height rule) and then press 

Ctrl K to open quick docs for help on that bit of code you have selected. You can also learn a 

lot about what certain CSS options do by simply changing them and seeing what happens. 

11. Add a style rule for the article element. 

article { 

  padding: 1rem; 

  font-size: 1.7rem; 

  margin-bottom: 5rem; 

} 
 

12. Under the footer css comment add a new style rule for the footer element. 

footer { 

  position: fixed; 

  background-color: rgba(23,28,49,1.00); 

  color: white; 

  bottom: 0px; 

  width: 80%; 

  max-width: 1100px; 

  text-align: center; 

  font-size: 1.5rem; 

} 
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We will have a background image for the page but we will give each page a different background 

image. So instead of putting it in the CSS file, we will put it in a style block on the page itself. 

13. Create a new style in the page. 

 

Add style properties for the html element in the current page. 

 

A style block will be added to the head section in the html. 
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Exercise 4. Navigation 

Now that we have the basic page layout we will add CSS rules to turn the unordered lists in the 

navigation and footer areas in to serviceable navigation bars. We’ll start with the links in the footer. 

1. Add the following CSS rules under the footer rule. 

footer li { 

  display: inline; 

  text-align: center; 

  margin: auto 5px; 

} 

footer a { 

  text-decoration: none; 

  display: inline-block; 

  color: rgba(115,138,191,1.00); 

} 

footer a:hover { 

  background-color: rgba(255,255,255,0.20); 

  color: white; 

  text-shadow: 0px 0px 5px yellow; 

  width: auto; 

} 

 

Before we add CSS rules for the navigation area, we will add a bit to the page. First, we will add an ID 

for the sub-menu so that it can be formatted differently from the rest of the menu. 

2. Select the second unordered list (the one containing the family names). 

 

3. Give this element an ID name of family. This will allow us to create a CSS rule that targets this 

individual list. 
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Add the following CSS rules under the navigation rule. 

nav ul { 

  padding: 0px; 

} 

nav ul #family { 

  padding-left: 1rem; 

} 

nav li { 

  list-style-type: none; 

  display: block; 

} 

nav li #family { 

  margin-left: 0px; 

} 

nav a { 

  display: block; 

  color: white; 

  padding: 0.5rem; 

  text-decoration: none; 

} 

 

We will create a class rule that can be used for whichever menu item points to the page that is 

currently showing. Then we will add a hover rule that applies to all of the other menu items. 

4. Add the following CSS rules for the navigation. 

nav a.active { 

  background-color: #738ABF; 

  color: yellow; 

} 

nav a:hover:not(.active) { 

  background-color: rgba(255,255,255,0.20); 

  color: white; 

  text-shadow: 0px 0px 5px yellow; 

} 

 

5. Select the Home link. 

 

6. Set active as the class. 
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Exercise 5. Using Script to Show and Hide Elements 

Current there is no link on the family item in the navbar list. We will change that so that when it is 

clicked on, it will switch the sub menu between displayed and hidden. To change the state of 

elements in a page in response to things like mouse clicks we will use some JavaScript. 

1. Edit the HTML so that the Family text has an anchor element around it. 

 

Add an ID so that we can refer to this element in our script. 

 

2. Lastly, add an event handler that will respond to a user clicking on this element (onclick) and 

then refer to a bit of script called showHide which we will add next. 

 

Go to the top of the page and add the following Script block to the Head section. 

 

When a user clicks the link, the onclick handler will activate this bit of code (called showHide). 

The code begins by creating a variable called vis which refers to the list element that we already 

labelled with the ID family. 

Now the code checks to see if the family is hidden (if the display is set to none). If it’s not then it 

changes it to a block display, making it visible. If it is not already hidden, then it makes it hidden by 

changing the display property to none. 

3. Preview the page and try the Family link. It should hide / display the list below it. 

Add 2 more style rules that will make the family list start off as hidden and make sure the family 

button changes the mouse to the pointer shape when moving over it. 
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4. Add the image called arrow.png next to the family link. 

 

We will add some lines to the javascript that make the arrow image appear normally when the list is 

hidden and rotate it downward when the list is visible. 

5. Modify the JavaScript as follows. 

 

 

 

Exercise 6. Media Queries for Mobile Layouts 

The final part of our page layout will be to add some media queries for different screen sizes. One 

section with rules for screens that are less than 950 pixels wide (such as tablet screens) and another 

section with rules for screens that are less than 600 pixels wide (phone screens). 

1. Under the mobile layout comment add the following CSS rules. 

/* mobile layout */ 

@media screen and (max-width: 950px) { 

  body { 

    width: 100%; 

  } 

  nav { 

    width: 100%; 

    height: auto; 

    position: relative; 

    font-size: 2rem; 

  } 

  nav ul { 

    display: flex; 

  } 
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  nav a { 

    background-color: rgba(23,28,49,1.00); 

  } 

  main { 

    margin-left: 0; 

  } 

  header { 

    float: left; 

    width: 100%; 

    font-size: 2.3rem; 

    overflow-x: hidden; 

  } 

  article { 

    width: 100%; 

    clear: both; 

    font-size: 2rem; 

  } 

  nav #index_family { 

    display: none; 

  } 

  footer { 

    width: 100%; 

    font-size: 1.9rem; 

  } 

} 

 

@media screen and (max-width: 600px) { 

  nav ul { 

    display: block; 

  } 

  nav a { 

    float: none; 

    text-align: center; 

  } 

} 

 

2. Test the page to see how it looks at different sizes. 
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Exercise 7. Additional Text Formatting 

Now to add some rules for general text formatting. Some of these will apply to elements that we will 

add to other pages in our site such as headings and tables. Note the use of the text-transform 

property which will show headings with the first letter of each word uppercase regardless of how it 

is typed in the code. 

1. Add the following CSS rules in the type section. As always, try modifying the values of some of 

these properties to see how they affect the way your page appears. 

h1 { 

  color: rgba(23,28,49,1.00); 

  font-family: Gotham, "Helvetica Neue", Helvetica, Arial, sans-serif; 

  font-size: 2em; 

  text-transform: capitalize; 

} 

h2 { 

  color: rgba(23,28,49,1.00); 

  font-family: Gotham, "Helvetica Neue", Helvetica, Arial, sans-serif; 

  font-size: 1.3em; 

  padding-top: 0.5em; 

  clear: both; 

} 

a { 

  color:blue; 

  text-decoration: none; 

  cursor: pointer; 

} 

a:hover { 

  text-decoration: underline; 

  color:red; 

} 

tr { 

  vertical-align: top; 

} 

 

Tip Remember if you want to learn more about a CSS property then click on it after you have 

typed it and then press Ctrl K to view Quick Docs. 
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Exercise 8. Index Page Content 

With the page layout in place we will add some more content to the index page and then create the 

other pages. 

1. Add a new paragraph under the text in the article section. In that paragraph add the images 

index_family.png, family1.png and family2.png with appropriate alt text for each one. 

2. Clear the height and width for each image if that was added by Dreamweaver as we will use CSS 

to specify the display sizes. 

3. Give each image the class “home_photos”. We will create a rule for that class in our CSS. 

4. Add an inline style to centre that paragraph. 

<article> 

  <p>Welcome to the website of the Nuklear family. We hope you will enjoy browsing 

through our site and finding out about our family.</p> 

  <p><a href="news.html">Take a look at the news page</a> to see pictures of our family 

vacation to lovely Batu.</p> 

  <p style="text-align: center" > 

  <img src="images/index_family.png" class="home_photos" alt="Nuklear family 

photo"/> 

  <img src="images/family1.png" class=" home_photos " alt="Nuklear family photo"/> 

  <img src="images/family2.png" class=" home_photos " alt="Nuklear family 

photo"/></p> 

</article> 

 

5. In your CSS file add a style rule for the photo_display class (in the main section). 

. home_photos { 

  height: auto; 

  max-width: 100%; 

} 

6. In the navbar add a paragraph beneath the menu. In that paragraph, add a copy of the 

index_family.png image including the photo_display class. 

 

Because that image uses our class rule which limits it’s size to no more than 100% width it will fit 

neatly in the nav bar. It won’t fit as well with our smaller screen layout though so we’ll add a rule 

that makes it hidden on smaller screens. 

7. Add the following CSS rule in the 950px mobile layout section of the CSS file. 
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Exercise 9. The Town Page 

This page will have a heading with some text and images.  

1. Make sure your index.html file is showing (not the CSS file). 

2. From the File menu select Save as (or press Ctrl Shift S). 

3. Enter town.html for the filename. 

 

4. Change the page Title to Nuklear Family Website - Our Town. 

5. In the Navigation area, remove the “active” class from the Home option and place it in the 

“Town” option. 

 

6. Change the background image (in the style block for the page) to house_3. 

 

7. Delete the content that is currently in the article section. 

8. Add a level 1 heading in the article section with the text Our Town. Since we already created a 

style rule for level 1 headings, those CSS properties will be applied. 

9. Add a paragraph under the heading with the following text. 

Our house is situated in the scenic town of Willow Creek which is only a short drive 

from Sim City. The family home is a 3 bedroom, 2 bathroom two story house with a 

study and pool. Take a look at the pictures below. 

10. Add another paragraph with the following text. The first words should be a link to the news.html 

page that we will create later. 

Take a look at the news page to see pictures of our family vacation to lovely Batu. 

11. Add a final centre aligned paragraph. In that paragraph add the 5 house pictures with suitable alt 

text (house_1.jpg, house_2.jpg etc). Remove any height and width attributes from the images. 

12. Create a new CSS class called photo_display. Add another rule for the same class in the mobile 

layout section. 

.photo_display { 
  height: auto; 
  max-width: 60%; 
} 

.photo_display { 
  max-width: 100%; 
} 
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13. Add the photo_display class to each of the images. 

 

Exercise 10. The News Page 

For the other pages we will make copies of the index.html page and then modify them. 

1. Make sure your index.html file is showing. 

2. From the File menu select Save as (or press Ctrl Shift S). 

3. Enter news.html for the filename. 

 

4. Change the page Title to Nuklear Family Website - News. 

5. In the Navigation area, remove the “active” class from the Home option and place it in the 

“News” option (in code view you can simply select the class and then drag it to the new spot). 

 

6. Change the background image (in the style block for the page) to house_2. 

 

7. Delete the content that is currently in the article section. 

8. Add a level 1 heading in the article section with the text What's been happening?.  

9. Add a paragraph under the heading with the following text. 

Check here for the latest family news. 

10. Below that paragraph add an ordered list like the following. 
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11. Next we will add 3 sections. Each section will have a level 2 heading followed by a paragraph of 

text. 

 

 

12. Under the text in the last section add an unordered list like the following. 

• Nick & Hondo 

• Lizzie & Rey 

• Elizabeth & Kylo 

• Elizabeth & Lizzie Exercising 

• Nick & Falcon 

• Lizzie driving lesson 

• Elizabeth helping out 

• A quick tour 

• Nick exploring 

• Winston & Hondo 

Each of the headings will have an image next to it. We will create a class that will set the images to a 

suitable size and float them to the right of the area. 

13. Create a class called news_photo. 

.news_photo { 

  float: right; 

  height: auto; 

  max-width: 50%;     

} 

14. Add the news_promotion.png photo next to the first heading with suitable alt text. Assign it to 

the new class and remove any height or width attributes. 

 

15. Add the image news_driving.png to the second heading and add the image batu_1.png (under 

the vacation folder) to the third heading. 
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Adobe Dreamweaver 2021  8 – Extra Challenge 

© Steve O’Neil 2022 Page 20 of 28 http://www.oneil.com.au/pc/ 

 

 

Exercise 11. Linking to IDs 

For out list at the top of the page we will turn each line in to a link that points to one of the headings 

on the page. To do that we will first add an ID to each heading. Then we can create a link that points 

to the ID. 

16. Select the first h2 tag and give it the ID promotion. 

 

 

17. Give the second heading the ID driving and the last heading the ID batu. 

18. Select the first line in the list (Winston's Promotion). Just like style rules reference IDs using a #, 

links also reference IDs using a #. 

19. Create a link to #promotion. 

20. Create similar links for the other two items in the list. 

 

Clicking those links in a browser will now go to the appropriate heading. This can be useful for long 

pages. 

 

Exercise 12. Changing Images 

For the list at the bottom of the page we will make each one a link that will change the picture to the 

right when the link is clicked. We could write our own bit of JavaScript to do that. Instead, we will 

use Dreamweaver’s Behaviours feature which can write script for you. 
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1. From the Window menu select the Behaviours panel to ensure it is showing (you might not be 

able to show it if you are in the Live view. Reposition the panel if needed. 

 

Before we can add a script that will change the picture shown in the image, we will need to assign an 

ID to the image which our script can refer to. 

2. Select the image next to the vacation heading and give it an ID of vacation_photos. 

 

 

3. In the code view, add an empty a tag around each of the list items. So each one will be a link that 

doesn’t yet go anywhere. 

 

4. Select the anchor tag for the first link. 

 

 

5. In the Behaviours panel click the Add Behaviour button. 

 

6. From the list of options choose Swap Image. 

From the list of images choose vacation_photos. 

7. Click the Browse button and choose the batu_1.png image from the images/vacation folder. 

8. Untick the Restore images onMouseOut option and click OK. 
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9. Change the behaviour from onMouseOver to onClick. 

 

Some new JavaScript has been added to the head section of the document. A small bit of code has 

been added to the body tag which refers to that script so that images are loaded when the page 

loads so they can appear immediately when the links are clicked. A small bit of code has also been 

added to the anchor tag which refers to the script. 

 

10. Repeat steps 4 to 9 to add behaviours for each other link in the list with each link loading the 

next image (I.e. the second link loading batu_2.png, the third link loading batu_3.png etc). 

 

11. Preview the page and test the links. 

 

Exercise 13. Adding Friends 

This page will have a heading followed by a table with images and text. 

1. Make sure your index.html file is showing. 

2. From the File menu select Save as (or press Ctrl Shift S). 

3. Enter news.html for the filename. 

 

4. Change the page Title to Nuklear Family Website - Friends. 
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5. In the Navigation area, remove the “active” class from the Home option and place it in the 

“Friends” option (in code view you can simply select the class and then drag it to the new spot). 

 

21. Change the background image (in the style block for the page) to house_4. 

 

6. Delete the content that is currently in the article section. 

7. Add a level 1 heading in the article section with the text A Few Of Our Family Friends.  

8. Add a table that is 8 rows and 3 columns. 

We will use CSS to set the width of each cell in the first row. The cells in the remaining rows will use 

the same widths. 

9. Select the first cell (td) in the first row and give it an ID of photo_column. 

 

10. Give the next two cells in the same row the IDs name_column and description_column. 

 

11. Create a CSS rule that sets the width for each ID. 

#photo_column { 

    width: 35%; 

} 

#name_column { 

    width: 10%; 

} 

#description_column { 

    width: 55%; 

} 

12. Add the following CSS rule that will create a new class to size the photos in the first column. 

.friend_photo { 

    height: auto; 

    width: 100%; 

    border-style: ridge; 

    border-width: medium; 

} 
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13. In the middle cell of the first row, type Jeannie & Shaun O'Hare. Format it as bold (strong). 

 

14. In the third cell of the first row enter the following text. 

Elizabeth's sister Jeannie and her husband live on a farm outside the city. 

 

15. In the first cell of the first column add the image called ohare.png from the friends folder. 

Remove any height and width attributes and apply the friend_photo class. 

 

 

16. Complete the table with text and images as follows, adding each friend’s name as alt text and 

the friend_photo class for each image. 

 

 

Jeannie & 

Shaun O'Hare 

Elizabeth's sister Jeannie and her husband live on 

a farm outside the city. 

 

Justin, George 

& Isaac Baker 

Winston went to school together with the Baker 

triplets who have all found success now as a 

scientist, an actor and a professional athlete. 

 

Ariel Triton Ariel is Lizzy's good friend who lives by the sea. 

Though Nick has always thought there's 

something fishy about her. 

 

Fox & Dana These 2 FBI agents sometimes hire Winston as a 

consultant when they need some scientific 

expertise on a case. 

 

DJ Steil Lizzy's favourite DJ who works on the local radio 

station during the week and works at the city's top 

clubs on weekends. 
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Frank Frank is Nick's pen pal from the distant country of 

Azeroth. His hobbies are travelling the 

countryside finding new forms of wildlife. 

 

Jane Shepard Winston's cousin is in the navy and travels on the 

SSV Normandy. 

 

John Marsden Winston's counsin from out west lives a peacful 

life with his family on his ranch 

 

 

17. Select the table element and set the padding property to 5 to allow some space around the 

photos. 

 

 

  

http://www.oneil.com.au/pc/


Adobe Dreamweaver 2021  8 – Extra Challenge 

© Steve O’Neil 2022 Page 26 of 28 http://www.oneil.com.au/pc/ 

Exercise 14. Family Pages 

Last but not least, we will create the pages for each family member. 

1. Make sure your index.html file is showing. 

2. From the File menu select Save as (or press Ctrl Shift S). 

3. Enter winston.html for the filename. 

 

4. Change the page Title to Nuklear Family Website - Winston Nuklear. 

5. In the Navigation area, remove the “active” class from the Home option and place it in the 

“Winston” option (in code view you can simply select the class and then drag it to the new spot). 

 

22. Change the background image (in the style block for the page) to house_5. 

 

6. Delete the content that is currently in the article section. 

7. Add a level 1 heading in the article section with the text Winston Nuklear.  

8. Add a paragraph with the following text. 

Dr Winston Nuklear is a former scientist who no teaches English at Willow Creek High 

School. He has an IQ of 178 and isn't afraid to use it. In his spare time he likes tinkering 

with gadgets around the house which usually involves fixing what he broke the last 

time he was tinkering. 

9. Add a centre aligned paragraph that contains the images winston1.png and winston2.png with 

Winston Nuklear is the ALT text. 

10. For each image, remove the height and width attributes and apply the photo_display class. 
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11. Save a copy if this page as elizabeth.html. 

12. Change the Title and navigation and then make the additional changes shown below, adding the 

text and both Elizabeth photos. 

 

13. Save a copy if this page as lizzy.html. 

14. Change the Title and navigation and then make the additional changes shown below, adding the 

text and both Lizzy photos. 
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15. Save a copy if this page as nick.html. 

16. Change the Title and navigation and then make the additional changes shown below, adding the 

text and both Nick photos. 

 

17. Save a copy if this page as pets.html. 

18. Change the Title and navigation and then make the additional changes shown below, adding the 

text and Pets photo (with the ALT text Lab & Slinky). 

 

 

Tip If you want to check any part of these exercises, there is a completed version at 

http://oneil.com.au/pc/dreamweaver.html . You can view the completed version in your 

browser and view code or inspect to compare with your site. 
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